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02- مقاطع -معرفی مصالح
و ترسیم آنها             



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
معرفی مصالح-2

:استنیاززیردرشدهذکرمواردبهبتنیساختماناعضایمعرفیجهتمعمولا

ستون-1

تیر-2

برشیدیوار-3

سقف-4

.شودمیاستفادهمیلگردومسلحبتنازآنهاتمامیدرکه

.گرددمیاستفادهساختمانملیمقررات9مبحثازفوقمصالحاطلاعات:نکته



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
معرفی مصالح-2

:منوی زیر مصالح معرفی می شوند از

Define-Material Properites



:               چند نکته •
 C40لیکن معمولا تا  ... تا C20(حداقل) معرفی شده در مقررات ملی ساختمان بین بتنیردهبتنی از مصالحجهت معرفی نام -1

.انتخاب می شود 
.بابت اجرا وجود داردنگرانیبتن با مقاومت فشاری بالا باعث کاهش ابعاد می گردد ، لیکن -2
(:  Weight Per Unit Volume)وزن واحد حجم بتن -3
الی 2300را معمولا ( بدون میلگرد تنها) در بتن های معمولی وزن واحد حجم بتن -3-1

2400Kg/m^3)  )در نظر می گیرند.
کرد  100را تقسیم  بر (  (Kg/m^3باید (   (KN/m^3جهت تبدیل واحد به -3-2

.23عددی حدود 
(  2)را به علاوه عدد KN/m^3) )23جهت درج عدد نهایی وزن واحد حجم بتن -3-3

(  25عدد نهایی ) هم محاسبه گردد آرماتورهاکرده تا وزن 
.سازه را محاسبه کند وزن کل بتن توجه شود نرم افزار با عدد فوق می تواند : نکته 
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کاربرد کامپیوتر درمهندسی عمران
معرفی مصالح-2



:               چند نکته •
:Eمدول الاستیسیته -4

را انتخاب کرد؟ Eدر مثال عددی مقابل کدام 
کمتره یا بیشتره ؟
بیشترEثابت فرض شود به ازای (F)اگر نیروی زلزله 

.کمتری داریم ( دریفت ) تغییر مکان 
جهت کنترل تغییربلند مرتبه با سازه در پروژه-4-1

.استفاده گرددبزرگترEاز ( دریفت)مکان 
ساختمان بلندبه خاطر طول بلندخود به طور-4-2

.طبیعی  انعطاف پذیری است 
ترکیب انعطاف پذیری و سختی مناسب برای -4-3

.طراحی مناسب است 
.کوچکتر استفاده شود  Eساختمان کوتاه به طور طبیعی سختی بیشتری دارد و بهتره از -4-4
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کاربرد کامپیوتر درمهندسی عمران
معرفی مصالح-2



.استفاده شود کوچکتر Eبیشتری دارد و بهتره از سختیساختمان کوتاه به طور طبیعی -4-4
29725برابر می گردد با   Eمگا پاسکال در نظر گرفته شود مقدار 40در مثال اگر مقاومت فشاری بتن را 

(فعلا ) طبقه در نظر بگیرید 10در عرف و سر انگشتی  معیار ساختمان کوتاه و بلند ساختمان -4-5
5-:U است 0.2ضریت پواسون در نرم افزار حدود.
6-A باضریب انبساط حرارتی کاری نداریم  وG مدول برشی

( .در مثالهای  کلاسی
:شوید… Modify/ show Propertyوارد قسمت -7
  Specified concreteصرفا مقدار -7-1

Compressive Strength    مقدار مقاومت فشاری(را
Mpaبتن کاریسبکقرار دهید و با مقدار مقاومت بتن 40 )

.نداشته باشید 
.معرفی شد  c40مقاومت بتن : نتیجه 

عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

کاربرد کامپیوتر درمهندسی عمران
معرفی مصالح-2



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
معرفی مصالح-2

:معرفی میلگرد به نرم افزار  (A615Gr65 ) 
بجایاطمینانجهتدرعرفدرمعمولا-1

S300ازS340شودمیاستفاده.

:نداردتغییربهنیازاستمناسبافزارنرممقدارزیردر-2

W-A-E

:شویدمیزیرقسمتوارد-3

Modify/ show Property …
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(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
معرفی مصالح-2

:معرفی میلگرد به نرم افزار  (A615Gr65 ) 

.کنندمیتولیدبیشتریمقادیرهاکارخانهعملدر:(حداقل)FUوFYمعرفی-1
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(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
معرفی مصالح-2

:معرفی میلگرد به نرم افزار  (A615Gr65 ) 

:انتظارموردFueوFYeمعرفی-2
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(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
معرفی مصالح-2

:معرفی میلگرد به نرم افزار  (A615Gr65 ) 

:انتظارموردFueوFYeمعرفی-2



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
معرفی مصالح-2

:معرفی میلگرد به نرم افزار  (A615Gr65 ) 

یرتاولزلزلهزماندریعنی،شودمیاستفادهضعیفتیروقویستونمفهوماز:انتظارموردFueوFYeمعرفی-2

.نکندریزشساختمانکلبتوانتابینندمیآسیبهاستونسپسبینندآسیبها

FYeFueتعریفباکهانددادهانجامهاییبینیپیشموضوعاینوقوعازجلوگیریجهتهانامهآیین ستونفلسفهاز-

تولیدرانظرموردشدهتعریفFY(300)همانمثلادقیقطوربهخانهکارچون)گرددمیاستفادهضعیفتیروقوی

میبیشتربالاترFYدلیلبهتیرمقاومتشرایطایندرلذا...و345یا340مثلاشودبیشترآنFYاستممکنوکندنمی

لذا،گرددبیشتراتصالناحیهمقاومتازداردامکانوشود

حداقلتیرمقاومت،کهشودطراحیطوریاتصالداردامکان

مقاومتازبیشتریناتصالناحیهمقاومتیعنیشودانتخاب

نکاتبایدافزارنرمدراینکاربرای،گرددبیشترتیرمحتمل

:کردرعایترازیر

FUوFYمقدارضربباراFueوFYeمقدارهانامهآیین

.کنندمیسبهمحا1.25در

S300پس – S400- C40اندشدهتعریفرا.
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(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

:Frame Sections
:ستونوتیرمعرفی-1

.کنیدحذفرااضافهمقاطع-1-1

:جدیدمقاطعتولید-1-2

-Add New Conceret

.شودمیانتخاببتنیمقاطعمتداولکارهایدر-
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(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

:انتخاب شکل پذیری 
.انتخاب می گرددمتوسطشکل پذیری -1

.برای ایران مناسب نیستکمشکل پذیری -2

بهتر است برای ساختمان ویژهشکل پذیری -3

.های  خاص استفاده گردد 



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

:Frame Sections
چهارممجهولتاکردهفرضراموردسهمقابلمجهول4از-1

.شودمیمحاسبه(تیرآرماتور)

.داردکاربردآناطرافوایرانمناطقبرایبلوکتیرچهسقف-2



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

:تخمین ابعاد ستونها -1
:ابعاد ستون -1-1
جهت قرار گیری ستون طوری فرض شده که  داخل فضای پارکینگ و یا فضای پذیرایی  قرار نگیرد وهمچنین ) ابعاد ستون ازنقشه های معماری استفاده کنید اولیهبرای بررسی -

.60در 30از (  602در 35( عرض )ابعاد ( 1: برای دانستن  ابعاد ستون  از فرض اولیه معمار  در نقشه ها استفاده می شود 

:مقدار آرماتورها -1-2
(شکل پذیری متوسط ) اورلبدر محل -درصد4حداکثرو 2.5حداقل: درصد فولاد مقطع-

.در بتن می گردد که هزینه ساخت آن را بالا می برد افزودنیموادمفدار فولاد باعث ایجاد تراکم میلگرد و نیاز به اسفاده از افزایشمعمولا -

انتخاب نشود بهتر است و یا کارفرما از قبل 22باید خارج از شهر خریداری گردد  ، لذا 22موجود است ، مثلا سایز 25-20–16در  بعضی شهر های  مثلا  آرماتور سایز -

.خریداری کرده لذا همان را باید خریداری کردد20آرماتور 

بتن بستگی به  وضعیت جوی هر شهر از نظر خورندگی دارد و آیین نامه ها جداولی برای تعیین آنها مشخصمقدارپوشش -

.میلی متر مناسب است 40کردند ، شهری مانند تهران عدد 

Generalقسمتدر- DateمثلاستونمقطعنامC60X35-12F25مقطعطولیوعرضابعادوگرددمیمعرفی،

/Modifyقسمتواردسپس Show Rebarشوید:
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(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

:تخمین ابعاد ستونها -1
:ابعاد ستون -1-1
جهت قرار گیری ستون طوری فرض شده که  داخل فضای پارکینگ و یا فضای پذیرایی  قرار نگیرد وهمچنین ) ابعاد ستون ازنقشه های معماری استفاده کنید اولیهبرای بررسی -

.60در 30از (  602در 35( عرض )ابعاد ( 1: برای دانستن  ابعاد ستون  از فرض اولیه معمار  در نقشه ها استفاده می شود 

:مقدار آرماتورها -1-2
((شکل پذیری متوسط ) اورلبدر محل )درصد4حداکثرو 2.5حداقل: درصد فولاد مقطع-

.در بتن می گردد که هزینه ساخت آن را بالا می برد افزودنیموادمفدار فولاد باعث ایجاد تراکم میلگرد و نیاز به اسفاده از افزایشمعمولا -

انتخاب نشود بهتر است و یا کارفرما از قبل 22باید خارج از شهر خریداری گردد  ، لذا 22موجود است ، مثلا سایز 25-20–16در  بعضی شهر های  مثلا  آرماتور سایز -

.خریداری کرده لذا همان را باید خریداری کردد20آرماتور 

بتن بستگی به  وضعیت جوی هر شهر از نظر خورندگی دارد و آیین نامه ها جداولی برای تعیین آنها مشخصمقدارپوشش -

.میلی متر مناسب است 40کردند ، شهری مانند تهران عدد 

Generalقسمتدر- DateمثلاستونمقطعنامC60X35-12F25مقطعطولیوعرضابعادوگرددمیمعرفی،

/Modifyقسمتواردسپس Show Rebarشوید:

To Be Checked:بارهایآرماتورمقداروستونابعادارایهبا،استبهتربگیردقرارقسمتایندرمرحلهایندر

؟(بندیرنگبا)یاخیرداردرابارهاتحملبرابردرمقاومتآیا،نمایدمیچکتحلیلازپسوواردکردهراسازهبروارد

To Be Designed:اینآناشکالولیاستلازمآرماتورمقدارچهدهدجوابستوناینکهبرایودهدمیقراررابارها

Toازشودمیتوصیهلذاگیردنمینظردررااجراییملاحظاتودهدمیایدهفقطکهاست Be Checkedشوداستفاده،

.ندارداشکالیهمدیگریازاستفادههرچند
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(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

. را پیشنهاد دهید و وارد کنید3و 2مقدارپوشش بتن و تعداد آرماتور در جهت -

.وارد می کنیم 25سایز میلگرد را مثلا -

آرماتور تفاوت آنها در دوآرماتور و دیگری سهدو تیپ وارد شده است ، یکی 3همانطور که در شکا بالا ملاحظه می گردد ، در جهت -

درصد مقدار آرماتور سه درصد می گردد ، و چون نرم افزار در مرحله چک هست 2.5مقدار درصد آرماتور افزایش می یابد ، یعنی بجای 

4لیکن  تا )قرار دهید درصد 3تا 2.5کنترل می کند ، لیکن پیشنهاد می گردد درصد آرماتور برای ستون را در مرحله اولیه بین 

(.درصد مجاز هستید 

.کنترل آزاد آرماتورها در کنار مقدار درصد مجاز تعریف شده در در آیین نامه بسیار مهم است -

به قسمت  -

.است (  غیر خطی ) کاری نداریم چون مربوط به قسمت تحلیل دینامیکی  Confinement Bars -  به قسمت

.  تعریف می کنیم  C60X30-12F25 یک  ستون دیگر هم به طور مشابه به ابعاد -
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(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

:تخمین ابعاد تیرها -2
:ابعاد تیر -2-1
سانتی متر 25سانتی متر کمتر باشد، که جمعا ده سانتی متر کمتر شود ، به شرطی که بعد تیر از 5ابعاد تیرها توصیه شده که تیر از طرفین ستون حداقل اولیهبرای بررسی -

.کمتر نشود 

. میلی متر است 500میلی متر کسر کنیم ، باقی مانده ابعاد تیر 100میلی متر است ، اگر 600با توجه به اینکه بعد ستون : تیر اول -
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(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

سانتی متر 25سانتی متر کمتر باشد، که جمعا ده سانتی متر کمتر شود ، به شرطی که بعد تیر از 5ابعاد تیرها توصیه شده که تیر از طرفین ستون حداقل اولیهبرای بررسی -

.کمتر نشود 

. میلی متر است 250میلی متر کسر کنیم ، باقی مانده ابعاد تیر 100میلی متر است ، اگر 350با توجه به اینکه بعد ستون : تیر دوم -
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(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

:تخمین ابعاد تیرها -
ارتفاع ( = آکس به آکس ) طول تیر * درصد5( :                     روش سر انگشتی یاعرف )ارتفاعتعیین -1

(400=0.05* 8000) میلی متر است ، لذا ارتفاع آن8000فاصله دهانه تیر اول حدود 

.می شود ( مطابق شکل زیر) محدودیت ابعاد تیر :  عرضتعیین -2

:ابعاد تیر اول -3
.میلی متر برآورد می گردد( 500) و عرض ( 400) ارتفاع : ابعاد تیر اول -

:مقدار فوق را به نرم افزار تعریف می کنیم -4
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(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

ت تا سطح است ، در ستونها از انتهای میلگرد خامومتفاوتدر تعریف ستون ها با تیر ها ( کاور ) مقدار پوشش بتن : سایر  مشخصات تیر را به نرم افزار تعریف می کنیم -5

میلی متر در نظر گرفته 10معمولا قطر میلگرد خاموت ) عبارت است از  Rebar Group Centerولی در تیر ها روش محاسبه ( مطابق شکل زیر ) بیرونی حساب می گردید 

(:مطابق شکل -می شود

mm))60 (  20/2)نصف قطر آرمانور طولی ( + 10) قطر خاموت( + 40)کاور= مقدار کاور تیر

به میزان 20اگر  فرضیات فوق درست نبود ، مثلا آرماتور تیر ها بجای –6

 Rebar Group Centerمقدار بود و یا دو لایه آرماتور داشتیم لذا 25

( :مطابق شکل زیر) فرق خواهد کرد 

-



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

.میلی متر قرار داد70یا 60را می توان  Rebar Group Centerدر این مثال مقدار –7



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

:تعریف سقف -3
: از آنجاییکه سقفهای تیرچه بلوک در نرم افزار وجود ندارد ، لذا باید با ترفندی آن را معرفی نمود 



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
Frame Sectionsمعرفی مقاطع  -3

:تعریف سقف -3

زیررد،کهگرددبلوکتیرچهسقفبهتبدیلگرددمیسعیآنداخلپارامترهایتغییربالذا،آیدمیفولادیعرشهسقفشکلشودداشتهنگهiحرفرویصورتیکهدر-

.گرددمیوارداعدادترراحتوماندمیباقیشکلکامپیوترکلیدصفحهدرTabدکمهداشتننگاهبا)استشدهدرجانمقادیر



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
معرفی ابزارهای کمکی-4

معرفی ابزارهای کمکی ترسیم-4
.د اییبه کمک ابزارها می توان ترسیم انجام داد ، جهت ترسیم سریعتر در جای خالی بالای صفحه کلیک راست کرده و ابزارها را انتخاب و فعال نم



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
ترسیم ستون ، تیر و سقف ها -5

ترسیم ستون ، تیر و سقف ها -5
ترسیم ستون ها-5-1

:شوداستفادهازمنوهازیرشکلمطابق

بهتوانمی،دکنمیترسیمافقیافزارنرمراستونشکل(فرضپیش)مبناحالتدرباشیم،داشتهساختهپیشبتنمگر،هستندگیردارهمیشهآرمهساختماناتصالاتدر-

:داددورانراستونروشدو

Angelقسمتدرابتداهمانازشدهبازپنجرهدر-1 .deg = .بزنیدرا90

<Assignمنویازاستفاده-2 Frame> Local Axes



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
ترسیم ستون ، تیر و سقف ها -5

یاضافآن و در انتها کنترل عدم نصب ستون دقیقو دقت در تعریف در محل Quick Draw Columnsبا انتخاب  :ترسیم ستون ها-5-1
-



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
ترسیم ستون ، تیر و سقف ها -5

 Rotate by  Angelو  Assign> Frame> Local Axesاستفاده از منوی ابتدا ستون های مورد نظر را انتخاب کرده  سپس ، با :ترسیم ستون ها-5-1

.درجه می زنید 90را -

.جهت پاک کردن محورهای محلی علامت زیر را بزنید : توجه 



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
ترسیم ستون ، تیر و سقف ها -5

:جهت پاک کردن محورهای محلی علامت زیر را بزنید : توجه :ترسیم ستون ها-5-1



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
و سقف ها تیرترسیم ستون ، -5

.برای رسم تیر از منوی مقابل اسفاده کنید : ترسیم تیرها  -5-2
کنید ، کلیک راست  دا  ابتحذف شبکه است ممکن است در زمان انتخاب تیر محور اشتباه  انتخاب شود ، لذا بهتر است بری ( محور ) پلان پر از آکس -

.است ستونآکسنشان داده شده  به معنی  jointمطابق  شکل زیر انتخاب نمایید ، سپس روی نمایشگر واژه 



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
و سقف ها تیرترسیم ستون ، -5

:ترسیم تیرها  -5-2



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
هاسقفترسیم ستون ، تیر و -5

:ترسیم سقف ها  -5-3
:در ابزارها سه حالت داریم -
1-Quick Draw  2زمانی رسم می کند که  شبکه ها روشن باشد  و فقط داخل اکس ها را رسم می کند-Draw Rectangular   جایی که پنل مستطیلی باشد ، لذا

آن را روی تیرچه قرار می دهیم Propertyدر این مثال به درد می خورد که   Draw Floor-3زمانیکه ذوزنفه ای باشد کاربرد ندارد  
.کنید از همان دستور قبل با کلیک راست پنهانرا مجدد شبکهجهت ترسیم راحت تر -
قسمت راه پله و آسانسور جزبهسقف ها را رسم می کنیم Jointبه  Jointاز -
مگر جاییکه طول دهانه زیاد ) باشد شطرنجیمی شود که جهت گیری تیرچه ها توصیهجهت ایجاد سقف صلب تیرچه بلوک در سقف های -
(7m)باشد.
تر قرار داده شود که کنترلهای بعدی بی دردسرتر باشد ، لذا جهت تغییر جهت تیرچه مطابقه شکل زیر کوتاهدهانهجهتتیرچه ها را در -

:  اقدام نمایید 



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
هاسقفترسیم ستون ، تیر و -5

:ترسیم سقف ها  -5-3
:در این قسمت وضعیت سقف در محل آسانسور ، راه پله و قسمت کنسولی را ترسیم می کنیم -1
با منظور رسم تیر زیر دیوار از دستور سپسمیلی متر را از اتوکد تعیین می شود ، 225اندازه تیر ابتدا-

Offset  رسم نماییم دقیقرا کجتیراستفاده می شود  تا دو نقطه کمکی تعیین نموده تا.

:رسم تیر-2
مطابق شکل تیر به انتها نمی رسد ، لذا
اشبکه را مجدد فعال کرده ، سپس تیر ر 
طعکمی بلندتر رسم می کنیم تا دوتیر راق
کند ، حال دو نقطعه را روی تیرها را 

مشخص کرده و با استفاده از نقطه های 
.  کمکی تیر را درست رسم می کنیم 



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
هاسقفترسیم ستون ، تیر و -5

:ترسیم سقف ها  -5-3
با داشتن دو نقطه مشخص تیر بین آنها رسم می کنیم ، سپس نقاط تقاطع تیر فرضی را بر روی تیر اصلی پیدا کرده تا بتوانیم( با زایده ) از خطوط شبکه استفاده می کنیم یک خط فرضی -

:  را رسم کنیم به شکل زیر



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
هاسقفترسیم ستون ، تیر و -5

:ترسیم سقف ها  -5-3
با داشتن دو نقطه مشخص تیر بین آنها رسم می کنیم ، سپس نقاط تقاطع تیر فرضی را بر روی تیر اصلی پیدا کرده تا بتوانیم( با زایده ) از خطوط شبکه استفاده می کنیم یک خط فرضی -

:  را رسم کنیم به شکل زیر
را فعال کرده تا دو نقطه کمکی دقیقا Intersectionقسمت   Draw>Snap Optionچون نقطه تقاطع با تیر را دقیق نمی توان از دستور فوق تعیین کرد ، از دستور -

.مشخص شود ، سپس با حذف تیر کمکی مانند شکل زیر نقاط باقی می مانند و می توان تیراصلی را رسم کرد 
.سپس سقف مربوط به این قسمت را رسم می کنیم ، چون طول دهانه ها کوتاه هست جهت تیرچه ها در این قسمت زیاد مهم نیست -
.را رسم کردسقفو تیرقسمت جلوی آسانسور نیز سقف می خواهد لذا مشابه روش قبلی باید -



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
هاسقفترسیم ستون ، تیر و -5

:ترسیم سقف ها  -5-3
م با داشتن دو نقطه مشخص تیر بین  آنهارسم می کنیم ، سپس نقاط تقاطع تیر فرضی  را بر روی تیر اصلی پیدا کرده تا بتوانی( با زایده ) از خطوط شبکه استفاده می کنیم یک خط فرضی -



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
هاسقفترسیم ستون ، تیر و -5

:ترسیم سقف ها  -5-3
(:بالکن ) ترسیم سقف قسمت کنسول-
.استفاده شود در کنسولها و پاگرد پله ها از جمله آن موارد است دال بتنی دو طرفه در چند مورد بهتر است از -
Membraneدال بتنی را درنرم افزاربه صورت لذا سقفکنیمنمیسقف استفاده سختی خمشی در تحلیل نرم افزاری از اثر -

انتقالرا بارولی (  ( سختی خمشی ندارند ) مقاومت نمی کنند تغییر شکل در مقابل )در نظر گرفته می شود  ( غشایی ) 
.می دهند

.تعریف می شود Membraneبه صورت پاگردو طبقاتسقف -
-Shellنوع سقف از کنسول ها صرفا در  - Thin استفاده می شود.
-Shellاز نوع  پی ها در - Thick  استفاده می شود.

حساب کنیم  ، لازم است محیط پیرامونی آن را حساب کرده و بر اگر بخواهیم از راه سر انگشتی: کنسول  ضخامت سقف
.جواب می دهد میلی متر 150قسیم کنیم ولی معمولا با تقسیم 180

را زده  برای سقف از قسمت  Draw Floorیا Draw Rectangularبا :ترسیم سقف کنسول
Property   گزینه کنسولCantilever  را  انتخاب کنید و سه نقطه مثلثی شکل کنسول را انتخاب کنید.

را  Stairمیلی متر رسم کنید،سپس سقف 1200سپس با تیر کمکی را برای رسم پاگرد راه پله با آفست:تعریف پاگرد 
.انتخاب  کرده و تیررا پاک کنید

.باشد تا خطا ایجاد نشود انگلیسیبه زبان ... هموارده نام فایل ، فولدر و: یاد آوری  



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
گیردارنمودن  تکیه گاهها-6

فرض تکیه گاه مفصلیبه صورت پیش ) دلخواه انتخاب کرده  elevationیک :گیردار نمودن تکیه گاه ها -6
را انتخاب کرده سپس  مطابق شکل زیر عمل کرده و( گره ها )کل تکیه گاه ها  plan Baseلذا با انتخاب  ( است 

.تکیه گاها را گیردار می کنیم 
:باید در سایر طبقات باید صورت پذیرد :ترسیم ستون ، تیر و سقف ها -7

Assign> Joint> Restraintمنوی   



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
ترسیم ستون ، تیر و سقف ها در تمام طبقات-7

باید در سایر طبقات باید صورت پذیرد:ترسیم ستون ، تیر و سقف ها در تمام طبقات مشابه-7
.نمایید Selectدر پلان طبقه اول رفته ، هر آنچه ترسیم شده را انتخاب -1
Edit >Repliaceبه -2 رفته و سپس مطابق شکل زیر تمام طبقات به جزطبقه اول و پشت بام را  …

.انتخاب کنید تا سایر طبقات ترسیم گردد 



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
ترسیم ستون ، تیر و سقف ها درخرپشته-7

:ترسیم ستون ، تیر و سقف ها در خرپشته-7
.رفته ، ستونها ترسیم و جهت تعدادی از آنها عوض نمایید 7در پلان طبقه -1
.رسم تیروسقف  صورت پذیرد-2
مطابق شکل سازه را حجم دهید -3

Viewو کنترل نمایید و یا از منوی 
Show Render View  را

.بزنید 

اگر در ترسیم سقف نوع : نکته
Property مثلارا اشتباه زده بودید

Slab تیرچه شود می توانید بهو بخواهید
:شکل زیر اصلاح نمایید 

Assign>Shell>Deck



عضو هیات علمی دانشگاه آزاد مشهد–سید ایمان غفوریان 

(  ETABS)کاربرد کامپیوتر درمهندسی عمران  
کنترل ترسیم های صورت گرفته-8

کنترل ترسیم های صورت گرفته
، 7در طبقه 29تا 26خطای زیر یعنی عضو تیر ) کنترل می گردد که سازه اشتباه ترسیم نداشته باشد   Select allو انتخاب  Analyze > Check Modelاز منوی -1

(دوبارکشیده شده  ، آنها را حذف کرده و مجدد کشیده شده لذا اینار خطا رفع گردیده

.در این مرحله اگر خطای روی نداد دلیلی ندارد که وافعا هیچ خطایی وجود ندارد -2
تجربه ای کسب کرده باشد  و به مرور ... کاربر باید بر روی ابعاد و آرماتور و-3

.متوجه شود که چه حدودی ابعاد و مصالحی  مناسب است 


